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How to Use Inspect Element Lee Stanton August 16, 2022 Press "Ctrl + A" (Windows) or "Cmd + A" (Mac). Or go to "Edit > Select All" if you're using a Mac or Windows computer. Double-tap and select "Select All" in the menu that appears on iPhone, iPad, and Android. 1 Press Control+A on the keyboard. This fast keyboard shortcut will select all
selectable items on the active window or page. For example, if you want to select everything in a Word document (including images and other objects), you can use this keyboard shortcut. Here's how it works: Click the window or page that you want to select. Press Ctrl and A at the same time. Everything that's selectable is now selected. 2 Use the
Edit menu in apps. If you're using an app that has an Edit menu, there will often be a Select all option in that menu. This tool works the same as using the Control + A keyboard shortcut, but you can access it through a menu instead. For example, let's say you're viewing a text file in Notepad. You can click the Edit menu and choose Select all to select
all characters in the text file at once. Another example is in iTunes—if you want to select all songs currently displayed in the window, click the Edit menu and choose Select all. If Select all is greyed out, you can't use select all on the current page or window. Advertisement 3 Use Windows File Explorer menus. If you're in a File Explorer window (e.g.,
browsing your documents or viewing the This PC folder), you can use the menu items in the upper-left side of the window to select all. Open the folder containing the files you want to select. Click the Home tab at in the upper-left corner of the window. Click Select all in the "Select" section of the toolbar at the top of the window. Everything in the
current panel is now selected. 4 Use the right-click context menu. In many cases, you can right-click a blank area of a window or website to bring up a context menu and choose Select All. This will typically select everything on the page, including text, photos, and other objects. Or, if you're browsing files, it will select every file in the window or panel.
If you don't have a right mouse button, tap two fingers together on your mouse's trackpad to bring up the menu. Advertisement 1 Press 3 Command+A on the keyboard. You can use this fast keyboard shortcut on nearly any window, page, or screen on your Mac to select everything that's selectable. For example, if you want to select everything inside
of your Pages document, including images and objects, you can use this keyboard shortcut. Here's how to use it: Click the window or page that you want to select. Press Command and A at the same time. This will highlight everything that can be selected. 2 Use the Edit menu. If you're using an app (including Finder) that has an Edit menu, you'll often
find a Select all option in that menu. It works the same as pressing Command + A, except you'll access it through a menu, not a keyboard shortcut. For example, let's say you're viewing a list of files in a Finder window. You can click the Edit menu and choose Select all to quickly select all files in the open folder. Another example is iTunes—if you want
to select all songs currently displayed in the window, click the Edit menu and choose Select all. If Select all is greyed out, you can't use select all on the current page or window. Advertisement 1 Select all text that you've typed. If you're using an app that allows you to type and you want to select all of the text you've entered, you can do so easily. This
will work when composing a message in Messages or Mail, typing in the Notes app, into browser forms, and in virtually any other app that allows typing. Here's how: Double-tap the first word you want to select. This highlights the word and places vertical selection bars on either side. Drag the selection bar on the right down and to the right until all
of the text is selected. Or, to quickly select all text in a paragraph, just triple-tap the first word.[1] If you're typing in a document in which you've inserted photos or other objects, this will select those objects as well. 2 Select everything in a document or on a website. This is similar to selecting text you've typed, but the steps are a little different. First,
you'll need to be using an app that has selectable text and/or images—emails, websites with text (as long as the text is actual text and not images), and the Amazon app all allow you to select text. Here's how to select all text in these types of apps: Tap and hold the first word you want to select. Lift your finger when the word is highlighted and you see
vertical selection bars on either side of the word. Drag the rightmost vertical selection bar down and to the right until you've highlighted everything on the page. Most social media apps won't allow you to select all text. If the text you're trying to select is actually an image (and it can be hard to tell), you usually won't be able to select it. 3 Selecting all
mail messages in the Mail app. Want to quickly select all of the messages in your inbox? If you're using the Mail app on your iPhone or iPad, you can. Here's how: Open the Mail app and go to your inbox. This will only work in the Mail app—you can't select all of your text messages in the Messages app. Tap the Edit link at the top-right corner of your
inbox. Tap Select All at the top-right corner. Advertisement 1 Select all text that you've typed. If you're using an app that allows you to type and want to select everything you've typed, you can do so easily. This will work when composing an email, writing a text message, filling out a form on a website, and virtually anywhere else that allows typing.
Here's how: Double-tap the first word you want to select. This highlights the word, adds two rounded selection sliders to either side of the word, and displays a menu. Tap Select all on the menu. If you don't see this option, try tapping the three dots to display more options. If you still don't see it, drag the rightmost selection slider down and to the
right until you've selected everything on the page. If the app you're using lets you insert photos and other objects, this will also select photos and objects you've entered. 2 Select everything in a document or on a website. If you're browsing a website, reading an email, or using another app that has selectable text and other objects, you can select
everything on the current page easily. Just keep in mind that not all apps have selectable text. For example, Facebook, Instagram, and Twitter don't allow selecting all text. Here's how to select all text on a page: Tap and hold the first word in the text you want to select. This highlights the word (don't lift your finger). Drag your finger downward and to
the right until you've highlighted everything else on the page.[2] Advertisement Add New Question Question How do I copy and paste on Windows 7? On any modern Windows computer, use {keypress|Ctrl|C} to copy and {keypress|Ctrl|V} to paste. Question How do I paste one page of a document? Highlight it with the mouse. Right-click it and select
and click copy. Click on the area you wish to put the text, then right-click and paste. Question How do you paste once you've selected with Apple? Either press Control and the "V" key at the same time, or right-click (do this on a touchpad by clicking with two fingers; if you have a mouse, press control, then click while holding). Select "paste." See more
answers Ask a Question Advertisement Thanks! Thanks! Advertisement Written by: wikiHow Technology Writer This article was written by Nicole Levine, MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has more than 20 years of experience creating technical documentation and leading support teams at major web hosting and
software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various institutions. This article has been viewed 827,624 times. Co-authors: 20 Updated: August 26, 2022 Views: 827,624 Categories: Basic Computer Skills Print Send fan mail to authors
Thanks to all authors for creating a page that has been read 827,624 times. "wikiHow is always there for me. Many thanks to those who take the time to contribute." Share your story by Avantix Learning Team | Updated April 7, 2021 Applies to: Microsoft® Word® 2010, 2013, 2016, 2019 or 365 (Windows) In Microsoft Word, images can be extracted
one by one or you can extract all images by converting a Word document to a zip file or saving it as a web page. Extracting all images is helpful if you'd like to find pictures that are inflated in size or reuse pictures in other files. In this article, we'll use 3 methods to extract images (we're referring to images or pictures that have been inserted into your
Word document, not shapes or SmartArt you've created). Recommended article: How to Reduce the Size of a Microsoft Word Document (10 Ways to Compress a Word File) Do you want to learn more about Word? Check out our virtual classroom or live classroom Word courses > You can extract individual images and save them as new files using Save
As Picture. There are two benefits to this method: You can give each image a meaningful name and save it in a specific location. You can save the image as a different file type. To save an image as a new file: Right-click the image and then click Save as Picture from the drop-down menu. In the Save as type drop-down menu, select the image file
format you want to use. You can save a picture in many formats but common choices are JPG or JPEG (Joint Photographics Experts Group) or PNG (Portable Network Graphics). In the File name box, type a name for the file. Navigate to the desired location. Click Save. Displaying file extensions in Windows In order to use the zip procedure (below), you
may need to display file extensions in Windows if they are not showing automatically. If you're using Windows 8 or 10: In File Explorer, click the View tab in the Ribbon. In the Show/Hide group, click the File name extensions check box. If you're using Windows 7: In Windows Explorer, click Folder and Search Options and then click Organize. On the
View tab, under Files and Folders, clear the check box for Hide extensions for known file types. Click OK. Extracting all images by changing the file to a zip format If you want to extract all images, the following trick works with any Microsoft Word file using XML (Extensible Markup Language) format. XML files are stored as a package and can
therefore be unzipped. They also end with an "x" such as .docx. In order to use the zip method, you will need a document created in Word 2007 or a later version and File Explorer or Windows Explorer must be set so that it shows file names with extensions (see the following section if extensions are not displayed). To extract all image files from a
Microsoft Word file: In File Explorer or Windows Explorer, select the document (it should have a .dotx extension) with the images you wish to extract. Right-click and choose Copy or press Ctrl + C. Right-click and choose Paste or press Ctrl + V. Right-click the copy of the document and choose Rename. Change the file extension from .dotx to .zip
(Windows must be set to display file extensions). Press Enter. A dialog box appears warning you that the file may become unusable if you change the extension. Click Yes to continue. The file icon changes to a folder icon. Double-click the zipped folder. The zipped folder contains multiple folders (some contain information such as XML code or
properties). Double-click the Word folder. Double-click the media folder to view image, video and audio files. Each file is given a generic name. Copy these files (or the entire folder) to another location to use in other documents and to rename the files. Copying to another location will unzip the files. You can also click the Extract button in Windows
Explorer to extract the files to another location. Below is a sample Word folder (with a media folder) created during this process: Extracting all images by saving the Word file as a web page Unlike PowerPoint, Microsoft Word files can be saved as web pages (HTML format). If you save a Word file as a web page, then separate files are created for
pictures and media files. To extract all image files from a Microsoft Word file by saving the file as a web page: Click the File tab in the Ribbon and select Save As. From the Save As Type drop-down menu, select Web Page. Enter a new name for the file. A .htm extension will be added. Click OK. A dialog box may appear indicating that you may lose
some formatting. Click Continue. Word will change the view to Web Layout View. Close the file. In File Explorer or Windows Explorer, navigate to the location in which you had saved the file. A folder should have been created with the same name and "files" at the end. Double-click the folder. Image, video and audio files should appear in this folder.
Each file is given a generic name. Right-click any of the files to rename them. Below are the contents of a folder that was created when a Word file was saved as a web page: When you open Word again, click the View tab and select Print Layout (the default view). It's up to you which method you'd prefer but the last two are the easiest if you are
extracting multiple images. Subscribe to get more articles like this one Did you find this article helpful? If you would like to receive new articles, join our email list. More resources How to Double Space in Word (4 Ways) 14 Shortcuts to Quickly Select Text in Microsoft Word How to Check Word Count in Microsoft Word (4 Ways) How to Show or Hide
White Space in Word Documents How to Create a Hanging Indent or First Line Indent in Microsoft Word Related courses Microsoft Word: Intermediate / Advanced Microsoft Excel: Intermediate / Advanced Microsoft PowerPoint: Intermediate / Advanced Microsoft Word: Long Documents Master Class Microsoft Word: Styles, Templates and Tables of
Contents Microsoft Word: Designing Dynamic Word Documents Using Fields VIEW MORE COURSES > Our instructor-led courses are delivered in virtual classroom format or at our downtown Toronto location at 18 King Street East, Suite 1400, Toronto, Ontario, Canada (some in-person classroom courses may also be delivered at an alternate
downtown Toronto location). Contact us at if you'd like to arrange custom instructor-led virtual classroom or onsite training on a date that's convenient for you. Copyright 2022 Avantix® Learning Microsoft, the Microsoft logo, Microsoft Office and related Microsoft applications and logos are registered trademarks of Microsoft Corporation in Canada,
US and other countries. All other trademarks are the property of the registered owners. Avantix Learning |18 King Street East, Suite 1400, Toronto, Ontario, Canada M5C 1C4 | Contact us at
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